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Introduction 
 

The main objective of Work Package 1 was to carry out a general work of data mining and 
analysis with respect to any information that may be useful, directly or indirectly, to the QIPC 
community in Europe. This task is concerned with establishing the framework and content of 
what is actually of interest for the community. In order to ensure maximum community 
coverage, and enable an unbiased view, a survey was initiated to collect input from different 
stake holders. This was the subject of Deliverable D1.1.1. 

The poll on the QUIE2T public forum1, which was also broadcast to the QUROPE mailing 
list2, has not produced any significant new insights as to new or un-covered material that 
could be collected in addition to the data we already have available. The community 
contribution to the services offered on our web site has certainly been significant, such that it 
can be concluded that the community needs in this area are covered to the satisfaction of all 
interested parties. 

 

  

                                                            
1 http://qurope.eu/content/survey‐relevant‐databases 
2 http://qurope.eu/content/qurope‐mailing‐list 

http://qurope.eu/content/survey-relevant-databases
http://qurope.eu/content/qurope-mailing-list


 

 

Fig. 1 Screenshot of the on‐line community survey 

 

 

Once the ‘hot’ topics had been identified, a general initial concept was worked out for the 
procedure of data collection and presentation. This was carried out in collaboration with WP3, 
whose responsibility it was to publish and disseminate the final analyzed material via the 
project web site. The preliminary concept of data collection and presentation was the subject 
of Deliverables D1.1.2 and D3.2.2; it is described in greater detail in this report, together with 
the final presentation of the data. 
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The main efforts connected to this task were put into the proper exploitation and visualization 
of the data collected on the qurope.eu web site. Since the beginning of the project, a 
dedicated space was reserved on the web portal to make available advanced functionalities, 
both for browsing and searching the databases, as well as submitting new data. 

The view of this data via the public qurope.eu web site, together with the advanced 
functionalities like searching, filtering and visualization, constitute a virtual QIPC observatory 
that is able to serve as a tool to highlight the development and advances in the field. The work 
on these Virtual Observatories has been the subject of Deliverables D2.3.1 and D2.3.2. 

The database main entry point is at 

http://qurope.eu/db 

This page also gives an overview of the latest database entries that is updated dynamically 
each time an entry is added or modified in the database, see Fig. 2. 

 

 

 

Fig. 2 The main entry point to the database collection. 
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Data submission 
 
 
Any registered user can submit new data via the node submission page3, however, in order to 
minimize the spam rate, we require people to login, i.e. anonymous submissions are not 
allowed. Registration is free and open to anyone, and can be accomplished quickly and easily 
by following the link below the User login block that is visible on bottom of the right column 
on every page of the site. 
 
Once logged in, some detailed documentation and help is available for submitting 
contributions and working with the on-line editor (see the ‚Compose tips‘ link in the menu). 
 
 
 

 
Fig. 3 The main page for data submission. 

 
  

                                                            
3 http://qurope.eu/node/add 

http://qurope.eu/node/add
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Apart from the main submission page, there is a link in the header of every database 
collection front page that goes directly to the data submission page for the corresponding data 
type. This is illustrated in Fig. 4 using as example the collection of QIPC projects4. 
 
 
  
 

 
 

Fig. 4 Example of a link from the database collection to the data submission page, 

 
 

Different data types offer the choice of various attributes to be specified during submission, 
some of which are required (indicated by a red asterisk), others are optional. These attributes 
can be modified any time later by editing the node (i.e. the submitted data type), and are used 
for filtering and searching on the respective presentation pages. This is illustrated in more 
detail in the next section, Data presentation. 

 

                                                            
4 http://qurope.eu/db/projects  

http://qurope.eu/db/projects


 
 
 
 

 

Fig. 5 Examples of data submission pages:  submit a job offer (above) and an event (below). 
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Data maintenance 
 

Once submitted, any data node and its attributes can be modified and edited to an almost 
arbitrary content. However, in order to avoid abuse and potentially minimize our spam rate, 
a special permission policy has been put in place for the editing of database items, or in fact, 
for any page on the qurope.eu web site. As mentioned above, only registered users can 
submit new material, i.e. anonymous submissions are prohibited. This guarantees that we can 
always track the origin of any site modification. 

After that, any submitted data item can only be modified by the user who submitted it, i.e. 
normal users cannot modify content that has been submitted by another user. Only some users 
with special permission, called authorized users, or site administrators, can modify any public 
content. Authorized users are manually designated by a site administrator. 

The complete description of our permission and security policy is documented in the 
Frequently Asked Questions on our site5. 

 

Presumed a user has sufficient permission for a given node and has logged in to the site, there 
will be an edit bar visible on top of the page, as illustrated in Fig. 6. The View tab is the main 
page for the data node, it shows the same page that would be visible for anonymous users. 
The other tabs may only be visible for users with required permissions. There is in particular 
the Edit tab that allows to modify the underlying data node as described above. 

Before submitting a modified data node, one has the possibility to view the changes and to 
preview the final result via buttons on bottom of the Edit tab. 

Note that in order to delete an item, one also has to follow the Edit tab where there is a Delete 
button on bottom of the page. 

 

Apart from these basic administration tabs, there are some additional options that are mainly 
useful for statistical purposes and are only visible to administrators. In particular, there is a tab 
that lists all the pages on the qurope.eu web sites that have a link to the current page (What 
links here), a tab that lists the page visits (Track), and a tab that allows to include the current 
page into a collection of related site pages (a so-called ‚Book‘, Outline). See Fig.  6 for an 
illustration. 

 

                                                            
5 http://qurope.eu/faq#t235n405  

http://qurope.eu/faq#t235n405
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Fig. 6 Illustration of the edit bar that  is only visible to registered users. Some of the  listed  items may only be visible to 
users with special permission. 

 

 

Revision information 
 

It should be noted that there is no general mechanism that allows to track changes on an 
arbitrary data item, i.e. there is no revision control (‚Track changes‘) system in place. There is 
however the possibility to track changes on specific data items, but this has to be explicitly 
selected by the user during the edit operation. This mechanism is in particular used for 
tracking changes in the QIPC Roadmap6 and the QICS scheme7. 

Otherwise, the only trace of changes in a data node are via the system logs, however, no 
detailed information about the nature of the changes is logged, and the logs are only kept for 
two weeks. After that time period, any trace of modifications on a data item is lost. 

                                                            
6 http://qurope.eu/content/Roadmap  
7 http://qurope.eu/content/qics‐book  

http://qurope.eu/content/Roadmap
http://qurope.eu/content/qics-book
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Data presentation 
 

Most data collections can be filtered interactively with respect to some attributes, e.g. news 
entries8 can be filtered by date, job entries9 can be filtered by location, etc. Most of these 
filters are self-evident, some filters are specific to our infrastructure and are common to many 
collections. These are in particular: 

• The ‚Subject‘ filter, that specifies on which sub-domain of the web site the given 
entry lives, 

• The ‚Virtual Institute‘ filter, that filters by the associated VI (if any), 
• The ‚Project‘ filter that filters any associated QIPC project. 

Other specific filters are explained at the corresponding database description below wherever 
they occur. 

 

Calendar views have been added for all data that support a date attribute (news, events,...) and 
map views for data that support locations (jobs, events,...). 

Each database presentation page also gives some basic statistics about the number of entries 
in the collection (subject to the currently active filter selection). 

Most data can be exported directly to an xls Excel stylesheet via a button on bottom of the 
corresponding page. 

At the time of this writing, there are the following top-level database topics available: 

 

• News 
• Events 
• Jobs 
• Publications 
• Links 
• Industries 
• Research Groups 
• PR Activities 
• Projects 

 

These topics and initial database seeds were mainly taken over from the predecessor projects 
ERA-Pilot QIST and QUROPE and enhanced with additional items following a public survey 
among the community members10. The newly collected data seeds introduced by QUIE2T are 
the Publications, Web links, Research groups, PR Activities and Projects. 
                                                            
8 http://qurope.eu/db/news 
9 http://qurope.eu/db/jobs 
10 http://qurope.eu/content/survey‐relevant‐databases  

http://qurope.eu/db/news
http://qurope.eu/db/jobs
http://qurope.eu/content/survey-relevant-databases


 

The following pages discuss the single databases in more details, highlight the evaluation and 
analysis tools available for each, and present a preliminary statistic evaluation and analysis of 
the available data as of the time of this writing. Essentially, this means that the presented data 
cover the period from 1. February 2010 – 15. January 2013. However, as database entries 
are added dynamically, specific numbers in some tables may change rapidly and significantly 
in real life, so the aim of this analysis is mainly to present an overview and discuss any 
significant trends that may be visible. 

 

A common feature for all main database pages is the header section, which usually gives the 
total count of database entries applicable to the current view, and a set of filters, that can be 
applied to the database set under consideration. This is illustrated in Fig. 5 using the Events 
database as an example. 

 
 

 
Fig.  7  Illustration  of  the  filtering  and  data  count  functionality  using  the  Events  database  as  an  example. Notice  the 
various highlighted search filters, and the data counter in the header above, that adjusts automatically to the currently 
selected filters. Similar tools are available for all other database collections. 
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News 

 

The complete collection of News submissions is available at http://qurope.eu/db/news. A 
News node is typically a short story or piece of content that can be submitted by site users and 
classified according to some searchable filter terms. News are most typically used by projects 
hosted on the qurope.eu site to display the latest submissions in the right column of the 
project web pages. An example is the News block of the QUIE2T web site itself11. However, 
also news not related to a specific project can be classified, e.g. general QIPC news12 or news 
related to the Virtual Institutes13. 

A particularly useful feature is the availability of RSS feeds for each news collection (e.g. per 
project), that allows users to subscribe to a feed and get automatic notification of any content 
addition or change. This is achievable via a small icon on bottom of the view. 

 

 
Fig. 8 Screen shot of the News database main page. 

 

 

 

                                                            
11 http://qurope.eu/quie2t  
12 http://qurope.eu/qipc  
13 http://qurope.eu/vi  

http://qurope.eu/db/news
http://qurope.eu/quie2t
http://qurope.eu/qipc
http://qurope.eu/vi


 

 

 

The News database can currently be filtered by Subject, Project, Virtual Institute and Date. In 
addition, an arbitrary text search may be performed on the News title, summary and body. 

 

Currently there are a total of 98 News database items available in the collection, i.e. we had 
roughly one news submission every two weeks. Evidently, this service is used to a different 
extend by different projects. The following table gives the number of news records filtered by 
Subject topic and the most active projects. Note that single numbers do not necessarily add up 
to the total number of records because some nodes may be classified within several 
categories. 

 

 

Subject Projects QUIE2T Virtual 
Institutes 

FP7 QIPC 

Nr. of records 27 29 4 7 50 

Project QUIE2T AQUTE Q-ESSENCE SOLID STREPS 

Nr. of records 29 16 26 3 3 
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Events 

 

The complete collection of Events is available at http://qurope.eu/db/events. An event is 
typically any type of happening like a conference or workshop that can be submitted by site 
users and classified according to some searchable filter terms. Typically, an event has a 
specific date and location, but there are exceptions as for example web conferences or on-line 
PR activities. Also public lectures or review meetings may be classified as events. 

Again, a particularly useful feature is the availability of RSS feeds for each event collection 
(e.g. per project), that allows users to subscribe to a feed and get automatic notification of any 
content addition or change. Another useful feature is the possibility to export the current view 
of the database to an Excel XSL style sheet. This is achievable via a small icon on bottom of 
the view. 

 

 

 

 

 
Fig. 9 Screen shot of the Events database main page. 
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http://qurope.eu/db/events


 

 
 

 
Fig. 10 Screen shots of the Events Google map (above) and calendar view (below). 
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The Events database can currently be filtered by Subject, Project, Virtual Institute, Date and 
Country. In addition, an arbitrary text search may be performed on the Event name and place. 

 

 

Currently there are a total of 168 database items available in the collection, i.e. we had 
roughly one event submission per week. The following table gives the number of event 
records filtered by Subject topic and the most active projects as well as the most frequent host 
countries. Note that single numbers do not necessarily add up to the total number of records 
because some nodes may be classified within several categories. 

 

 

Subject Projects QUIE2T Virtual 
Institutes 

FP7 QIPC 

Nr. of records 16 9 1 8 150 

Project QUIE2T AQUTE Q-ESSENCE SOLID STREPS 

Nr. of records 9 16 7 3 8 

Country Germany Austria Spain Italy UK 

Nr. of records 20 19 17 15 15 

 

 

Note that in addition to the filter-enabled default view, there is also a browse-able calendar 
view14 and a Google map view15 as well as a collection of external sites with independent 
event listings16. 
  

                                                            
14 http://qurope.eu/db/events/calendar  
15 http://qurope.eu/db/events/map  
16 http://qurope.eu/db/events/external  

http://qurope.eu/db/events/calendar
http://qurope.eu/db/events/map
http://qurope.eu/db/events/external


Jobs 

 

The complete collection of Job offers is available at http://qurope.eu/db/jobs. The job 
collection is by far the most popular database of the qurope.eu web site. According to 
Google analytics it has been hit over 4000 times in the past year, i.e. about 10 times per day, 
accounting to almost 5% of the total site traffic, which makes it the most visited page on the 
whole qurope.eu site.  

Again, a particularly useful feature is the availability of RSS feeds for the whole database 
collection that allows users to subscribe to a feed and get automatic notification of any content 
addition or change. Another useful feature is the possibility to export the current view of the 
database to an Excel XSL style sheet. This is achievable via small icons on bottom of the 
view. 

 

 
 
 

 

Fig. 11 Screen shot of the Jobs database main page. 
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Fig. 12 Screen shot of the Jobs Google map view. 
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The Jobs database can currently be filtered by Job type (Position, Postdoc or PhD), 
Application deadline and Country. In addition, an arbitrary text search may be performed on 
the Job title and place. 

 

 

Currently there are a total of 220 Job offers available in the collection, i.e. we had roughly 
three job submission every two weeks. The following table gives the number of job records 
filtered by job type and the most frequent host countries. Note that single numbers do not 
necessarily add up to the total number of records because some nodes may be classified 
within several categories. 

 

 

Job type Position Postdoc PhD   

Nr. of records 36 132 71   

Country Germany Austria Spain USA / France 
/ Australia 

UK 

Nr. of records 30 18 24 12 50 

 

 

Note that in addition to the filter-enabled default view, there is also a Google map view17 as 
well as a collection of external sites with independent job listings18. 
  

                                                            
17 http://qurope.eu/db/jobs/map  
18 http://qurope.eu/db/jobs/external  

http://qurope.eu/db/jobs/map
http://qurope.eu/db/jobs/external


Publications 

 

The complete collection of Publications is available at http://qurope.eu/db/publications. The 
publication collection is the largest collection of data items on the qurope.eu web site with 
currently 612 single records. 

Again, a particularly useful feature is the availability of RSS feeds for the whole database 
collection that allows users to subscribe to a feed and get automatic notification of any content 
addition or change. Another useful feature is the possibility to export the current view of the 
database to an Excel XSL style sheet. This is achievable via small icons on bottom of the 
view. 

 
 

 

Fig. 13 Screen shot of the Publications database main page. 
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The Publications database can currently be filtered by Subject, Project, Virtual Institute, Date 
and QICS. In addition, an arbitrary text search may be performed on the Publication title, 
author(s), reference and abstract. 

 

 

Currently there are a total of 612 Publications available in the collection, i.e. we had roughly 
four submissions per week. The following table gives the number of publications filtered by 
Project, Virtual Institute and QICS. Note that single numbers do not necessarily add up to the 
total number of records because some nodes may be classified within several categories. 

 

 

Virtual 
Institute 

Q-Comm Q-Comp Q-Info Q-Tech  

Nr. of records 18 100 129 90  

QICS 00 10 20 30 40 

Nr. of records 123 196 23 29 17 

 

 

On a side note it has to be mentioned that the classification according to QICS (Quantum 
Information Classification Scheme19) terms might not be very representative as not all 
publication records have been classified by it. It was only in Oct. 2012 that indicating a QICS 
scheme was made mandatory when submitting a publication, i.e. many older entries do are not 
tagged with any QICS at the moment. Work to classify the remaining publication records is 
on-going at the moment. 
  

                                                            
19 http://qurope.eu/content/qics‐book  

http://qurope.eu/content/qics-book


Links 

 

The complete collection of Web Links is available at http://qurope.eu/db/links. 

Again, a particularly useful feature is the availability of RSS feeds for the whole database 
collection that allows users to subscribe to a feed and get automatic notification of any content 
addition or change. Another useful feature is the possibility to export the current view of the 
database to an Excel XSL style sheet. This is achievable via small icons on bottom of the 
view. 

 
 

 

Fig. 14 Screen shot of the Weblinks database main page. 
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The Links database can currently be filtered by Type, Country, Attribute and Date. In 
addition, an arbitrary text search may be performed on the Link title and description. 

 

 

Currently there are a total of 309 distinct links available in the collection, i.e. we had almost 
two submissions per week. The following table gives the number of web links filtered by 
Type, and as an interesting sub-category, the number of ‘Media appearances’ per country. 
Note that single numbers do not necessarily add up to the total number of records because 
some nodes may be classified within several categories. 

 

 

Type QIPC In the Media Introductory 
Material 

Job listing Software 

Nr. of records 30 211 42 16 12 

In the Media 
per Country 

Austria Germany France Switzerland UK 

Nr. of records 55 54 54 12 22 
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Industries 

 

The complete collection of Industries is available at http://qurope.eu/db/industries. 

 

Again, a particularly useful feature is the availability of RSS feeds for the whole database 
collection that allows users to subscribe to a feed and get automatic notification of any content 
addition or change. Another useful feature is the possibility to export the current view of the 
database to an Excel XSL style sheet. This is achievable via small icons on bottom of the 
view. 

 

 
 

 

Fig. 15 Screen shot of the Industries database main page. 
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The Industries database can currently be filtered by Country, Virtual Institute and Interests. In 
addition, an arbitrary text search may be performed on the name of the Industry. 

 

 

Currently there are a total of 50 distinct Industries in the collection. This number has stayed 
roughly constant over the past years as we had a few additions but also a few removals of 
start-up companies that apparently have disappeared again. 

 

The following table gives the number of industry records filtered by Country, Virtual Institute 
and Interest. Note that single numbers do not necessarily add up to the total number of records 
because some nodes may be classified within several categories. 

 

 

Country UK Germany France USA Switzerland 

Nr. of 
records 

7 6 5 7 6 

Virtual 
Institute 

Q-Comm Q-Comp Q_Info Q-Tech  

Nr. of 
records 

7 1 0 2  

Interest Cryptography Quantum 
Technology 

Security Communication Networks 

Nr. of 
records 

11 17 12 15 11 

 

Note that in addition to the filter-enabled default view, there is also a Google map view20 
showing the location of company headquarters on a Google map. 
  

                                                            
20 http://qurope.eu/db/industries/map  

http://qurope.eu/db/industries/map


Research Groups 

 

The complete collection of Research Groups is available at http://qurope.eu/db/groups. 

 

Again, a particularly useful feature is the availability of RSS feeds for the whole database 
collection that allows users to subscribe to a feed and get automatic notification of any content 
addition or change. Another useful feature is the possibility to export the current view of the 
database to an Excel XSL style sheet. This is achievable via small icons on bottom of the 
view. 

 

 
 

 

Fig. 16 Screen shot of the Research Groups database main page. 
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Fig. 17 Screen shots of the group contacts page (above) and the groups Google map view. 
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The Research Groups database can currently be filtered by Name, Research Type, Expertise, 
Country, City and Group leader. 

 

Currently there are a total of 203 distinct Research Groups in the collection. This number has 
only slightly increased over the past years as we had already a rather complete coverage of 
groups when the database was taken over from previous projects, and there were only a few 
newly emerged groups in addition. 

 

The following table gives the number of Research Groups records filtered by Country, 
Research Type and Expertise (selected by some prominent key words). Note that single 
numbers do not necessarily add up to the total number of records because some nodes may be 
classified within several categories. 

 

 

Country UK Germany France Italy Spain 

Nr. of records 22 48 17 30 16 

Research 
Type 

Theory Experiment    

Nr. of records 105 112    

Expertise Cryptography Spectroscopy Optics Communication Networks 

Nr. of records 24 8 55 20 6 

 

Note that in addition to the filter-enabled default view, there is also a Google map view21 
showing the geographic location of research groups on a Google map. 
  

                                                            
21 http://qurope.eu/db/groups/map  

http://qurope.eu/db/groups/map
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PR Activities 

 

The complete collection of PR Activities is available at http://qurope.eu/db/pr-activities. 

Under PR Activity we initially understood any type of activity that was directed towards an 
extra-scientific audience, in particular the general public. So this could be for instance public 
talks, TV/Radio interviews, exhibitions or links to introductory material on the web, in 
particular videos on youtube.com or articles in the popular press. Due to the wide subject 
nature, and also in particular due to different interpretations and needs of various projects, we 
were soon forced to loosen that definition and introduce a range of subject tags that are not 
always immediately attributable to a conventional PR activity as described above. This makes 
it especially difficult to arrange, present and analyze the data. 

As a particularly confusing topic, there exist two types of ‘PR Activities’ in our collection: 
one that is particularly defined as such (in Drupal terms: a PR Activity Content Type), and one 
that only carries the attribute of ‘PR Activity’ (i.e. in Drupal terms: a Taxonomy Term). The 
latter may be any data node or content type (e.g. an event, a news story, a web link, etc.) that 
has been tagged with an attribute of ‘PR Activity’. As an example, the database for web 
links22 includes an Attribute filter that contains a ‘PR Activity’ tag. 

As a consequence, not all data submissions that have been tagged as a ‘PR Activity’ are 
necessarily included on the main page of the PR Activity database. To keep the search and 
filter functionality as general as possible without paying too much in terms of usability, we 
have added a few sub-categories in the navigation menu of the database that contain some 
special, but commonly used cases. Those sub-categories are ‘In the media’23, 
‘Presentations’24, ‘Communications’25 and ‘Other Activities’26. The latter page includes all 
data with a ‘PR Activity’ tag, irrespective of its data type. Like above, this does not 
necessarily include all the ‘proper’ PR Activities, i.e. the content types. All these sub-
categories may be filtered separately by some common terms. 

 

As for all other databases we note the availability of RSS feeds for the whole database 
collection that allows users to subscribe to a feed and get automatic notification of any content 
addition or change, as well as the possibility to export the current view of the database to an 
Excel XSL style sheet. This is achievable via small icons on bottom of the view. 

 
  

                                                            
22 http://qurope.eu/db/links  
23 http://qurope.eu/db/pr‐activities/media  
24 http://qurope.eu/db/pr‐activities/presentations  
25 http://qurope.eu/db/pr‐activities/communications  
26 http://qurope.eu/db/pr‐activities/other  

http://qurope.eu/db/pr-activities
http://qurope.eu/db/links
http://qurope.eu/db/pr-activities/media
http://qurope.eu/db/pr-activities/presentations
http://qurope.eu/db/pr-activities/communications
http://qurope.eu/db/pr-activities/other


 
Fig. 18 Screenshot of the main PR activities database page. 
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The ‘proper’ PR Activities database can currently be filtered by Attribute, Project and Format. 
In addition, an arbitrary text search may be performed on the PR activity title and description. 

 

Currently there are a total of 321 distinct PR Activities in the collection, i.e. we had about 2 
submissions per week. Note however that some projects classify, say, normal conference 
presentations as PR Activities, which is not the initial intent of the category. 

 

The following table gives the number of PR Activity records filtered by Attribute, Project and 
Format. Note that single numbers do not necessarily add up to the total number of records 
because some nodes may be classified within several categories. 

 

 

Attribute PR Activity Presentation Results Communications Highlight / 
Reports 

Nr. of records 37 286 31 4 1 

Project AQUTE Q-ESSENCE SOLID QUIE2T  

Nr. of records 0 142 168 1  

Format Talk Invited Talk Poster Media 
appearance 

 

Nr. of records 21 53 8 3  
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Projects 
 

The complete collection of QIPC Projects is available at http://qurope.eu/db/projects. 

The start of data collection for this data base is somewhat 6 years ago, i.e. 2007 with the start 
of the predecessor project QUROPE. That means that projects from the pre-FP6 era are 
usually not contained in the database. 

Again, a particularly useful feature is the availability of RSS feeds for the whole database 
collection that allows users to subscribe to a feed and get automatic notification of any content 
addition or change. Another useful feature is the possibility to export the current view of the 
database to an Excel XSL style sheet. This is achievable via small icons on bottom of the 
view. 

 

 

 

Fig. 19 Screen shot of the QIPC Projects database main page. 
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http://qurope.eu/db/projects


 

Fig. 20 Screenshot of the QIPC projects Google map page. 
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The Projects database can currently be filtered by Start/End Date, Virtual Institute, 
Coordinating Country, Funding Body and Type. In addition, an arbitrary text search may be 
performed on the Project acronym and coordinator. 

 

Currently there are a total of 54 distinct Projects in the collection. This number has steadily 
increased over the past years with an almost constant number of projects being added each 
year. 

The following table gives the number of Project records filtered by Virtual Institute, 
Coordinating Country, Funding Body and Type. Note that single numbers do not necessarily 
add up to the total number of records because some nodes may be classified within several 
categories. 

Country UK Germany France Italy 
Austria / 
Sweden 

Nr. of records 9 7 5 11 4 

Virtual Institute Q-Comm Q-Comp Q-Info Q-Tech  

Nr. of records 4 12 10 13  

Funding Body EC – FP7 EC – FP6 ESA ESF 
CHIST-
ERA 

Nr. of records 40 12 1 1 8 

Type CA IP STREP   
Nr. of records 4 7 40   

 

Note that in addition to the filter-enabled default view, there is also a Google map view27 
showing the geographic location of the project coordinating country on a Google map. 

                                                            
27 http://qurope.eu/db/projects/map  
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